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SECTION 2: BOSGaNOVA TCP/IP
CONFIGURATION AND ADMINISTRATION

BOSaNOVA TCP/IP includes several modules or components to help you
configure, administer, and customize the software. These are:

¢ The Administrator
Use to set and maintain overall parameters, see p. 39

* The TCP/IP Configurator
Use to define the TCP/IP connection, proxy servers, and ports, see p. 42

* The Emulation Configurator
Use to define emulation sessions, see p. 43

*  The BOSANOVA Emulation
The environment in which you run your host applications, see p. 45

» Keyboard Customization, see p. 56
* Toolbar Customization, see p. 63
* Hotkey Customization, see p. 67

*  MorphExpress
An tool that converts your host screen into a GUI screen, see p. 68

* Printer Driver Editor
Use to customize the printer driver, see p. 70

» Data Transfer Function
A 32-bit Windows utility for transferring data in either direction between a
PC and a host, see p. 72

* Host Explorer
View your AS/400 as if it were another drive on your PC, see p. 76

* Remote Command
Send an AS/400 CL command to a host system from a PC, see p. 78




BOSaANOVA TCP/IP DESCRIPTION

BOSaNOVA TCP/IP combines B.O.S. TN5250E display emulation with DTF
software in a package that is specifically designed for direct BOSaNOVA
XTC-to-AS/400 or iSeries connectivity.

BOSAaNOVA TCP/IP includes the following program modules:

Display/Printer Emulation provides TN5250E display and printer
emulation

Management Module—installed from the CD-ROM onto the server—
enables centralized management of multiple stations within a BOSANOVA
TCP/IP network

Printer Driver Editor enables you to customize the printer driver

DTF (Data Transfer Functions) is a 32-bit Windows utility for transferring
data between a BOSaNOVA XTC and its host

Host Explorer, a utility for viewing your AS/400 or iSeries as if it were a
drive on your BOSaNOVA XTC

BOSANOVA TCP/IP Features

supports up to 32 simultaneous display and/or printer emulation sessions

includes MorphExpress for converting host screens to true GUI screens
without changing the host application

supports Text Assist
supports 3477FC devices (132-column display with color)

supports PC and Terminal styles for keyboards, allowing you to work with
either a 101/102-key keyboard or the B.O.S. 122-key keyboard

supports the Euro symbol

includes comprehensive keyboard mapping and customization, using Shift,
Caps Lock, Alt, Ctrl, function keys, etc.

includes Print Preview, which displays print output before sending the print
job to the physical printer

includes Printer Session Properties, for modifying printer session settings

includes customizable “floating” toolbars and Internet Explorer-type
toolbar buttons

supports user-definable macros

includes BOSaNOVA EHLLAPI/DDE Interface 32, which sets a standard
IBM EHLLAPI-style interface for enhancing interaction between host
sessions and Windows applications

BOSANOVA TCP/IP Description



THE ADMINISTRATOR

The Administrator provides an overall view of various parameters relating to
your installation of BOSANOVA TCP/IP. The Administrator also enables you
to run certain administrative procedures.

Opening the Administrator

To open the Administrator:

1.
2.

3.

Click the Windows Start button.
Select Programs > BOSaNOVA TCP/IP.

Select ﬁ Adrinistrator

The top pane of the Administrator uses a Windows-style tree structure to
display the parameters and installed modules. To use this structure:

An item preceded by a plus sign (+) contains nested items. Click the plus
sign to expand the item (display the nested folders).

An item preceded by a minus sign (-) is already fully expanded. Click the
minus sign to collapse that part of the tree.

Names of parameter sets appear in black, while the current status values
appear in blue. Values always appear in arrow brackets (<>).

When you select a parameter set or installed module in the top pane, the
buttons and controls that configure or run that parameter set or module
appear in the bottom pane.

Installation Parameters

When Installation Parameters, in the top pane of the Administrator, is
expanded, the following parameters are displayed:

Product Version
The installed version of BOSANOVA TCP/IP. Technical Support ask for
this number if you contact them for help.

Installation Type
Standalone for BOSANOVA Thin Client.

Installation Path
The path to which BOSaNOVA TCP/IP is installed.

Installation Set
The set number.

Product ID
The BOSaNOVA TCP/IP product ID. Technical Support will ask for this
number if you contact them for help.

BOSGNOVA XTC Thin Client



Administrative Parameters

Connectivity

When Administrative Parameters in the top pane of the Administrator is
expanded, the following parameters are displayed:

Host Language/Country

The host keyboard ID (language), the host EBCDIC code page used, and
the EBCDIC/ASCII translation table that is used. These values were
defined when you installed BOSaNOVA TCP/IP.

License
Displays the license type.

Euro Support

The euro is the single currency of the European Monetary Union that was
be adopted by 11 member states on 1 January 1999. If you select this
option and your Windows system and the host are set to support the euro
symbol, BOSANOVA TCP/IP uses new euro symbol-compliant keyboard
type and code page IDs when allocating a session and new EBCDIC/ANSI
and ANSI/EBCDIC tables with euro symbol support. If your host or
Windows system do not support the euro symbol, do not select this
checkbox. See “Euro Symbol Support” on page 70 for details on system
requirements, changes, and patches.

When Connectivity, in the top pane of the Administrator, is expanded, the
following parameter is displayed:

Connection Type
TCP/IP

Run
(This button is disabled for the TCP/IP connection type.)

Configure
Click to open the TCP/IP Configurator to configure the connection.

The Administrator



Installed Modules

When Installed Modules, in the top pane of the Administrator, is expanded, all
currently installed BOSANOVA TCP/IP components are displayed:

Display/Printer Emulation
5250 display and printer emulation.

DTF

DTF (Data Transfer Functions) is a 32-bit Windows utility for transferring
data between a BOSANOVA XTC and its host. (See “DTF (Data Transfer
Function)” on page 72.)

Host Explorer
Host Explorer allows viewing your AS/400 as if it were a drive on your
BOSaNOVA XTC. (See “Host Explorer” on page 76.)

Run
Click this button in the bottom pane to run:

* the emulation (if you chose Display/Printer Emulation)
« DTF
*  Host Explorer

Configure
Click this button in the bottom pane to configure the selected module:
emulation or TCP/IP connection.

Diagnostics

If you contact Technical Support with a problem, they may ask you to provide
them with special files to help them solve it. This process is explained in
“Traces and Screen Captures” on page 80.

Expand Diagnostics in the Administrator display tree to display the following
parameter:

* Troubleshooting Information
Click Collect Technical Information to open the User Information

dialog box; fill in the information requested to create the information
file (default Bsinfo.bts).

@ You must close all sessions before accessing Diagnostics.

5 BOSGNOVA XTC Thin Client



THE TCP/IP CONFIGURATOR

Use the TCP/IP Configurator to configure parameters for your BOSANOVA
XTC to host communication. The TCP/IP Configurator opens automatically
when you start BOSANOVA TCP/IP. You can access it any time to change
parameters.

Starting the TCP/IP Configurator

Close all sessions and run the Administrator.
Expand Connectivity in the top pane and click Connection Type.

In the bottom pane, click Configure to open the TCP/IP Configurator.

b=

Set the parameters and click OK until you exit the Administrator.

Using the TCP/IP Configurator

Configurator parameters are divided among the following two tabs:

* Basic
Add, modify, or delete host systems and define security parameters.
For details, see TCP/IP Configurator in online Help.

* Advanced
Define or enable the proxy servers (Telnet, SOCKS, and FTP), LDP
ports, Keep Alive Mode, and Management Module parameters.

The top pane of the Advanced Tab uses a Windows-style tree structure to
display the parameters. To use this structure:

* Anitem preceded by a plus sign (+) contains nested items. Click the plus
sign to expand the item (display the nested folders).

* Anitem preceded by a minus sign (-) is already fully expanded. Click the
minus sign to collapse that part of the tree.

» The names of the parameter sets appear in black, while the current status
values appear in blue. Values always appear in arrow brackets (< >).
When you change a parameter, it appears in red until you click OK.

*  When you select a parameter set in the top pane, the buttons and controls
that configure or run that parameter set appear in the bottom pane.

Select a proxy server in the top pane and use the dialog box that appears in the
bottom pane to define or modify the connection. For details, see TCP/IP
Configurator in online Help.

The TCP/IP Configurator



THE EMULATION CONFIGURATOR

Use the Emulation Configurator to change the parameters that control the look
and operation of the BOSANOVA TCP/IP emulation and to define sessions.

@ You can access the Emulation Configurator while the emulation is running, but
you can not add or change sessions while sessions are open.

Starting the Emulation Configurator

When the Emulation is closed, from the Start Menu, select Programs *

BOSANOVA TCP/IP and select fB4 BOS&NOYA Configurator . From the Emulation

* Click & from the emulation toolbar, or

» Select File * Run Configurator from the emulation menu bar.

Using the Emulation Configurator

Configurator parameters are divided among two tabs, Sessions and Advanced
Properties:

Sessions Tab
For adding, modifying, or deleting display and printer emulation sessions.
See The Emulation Configurator in online Help for details.

Advanced Properties Tab
For adding, modifying, or deleting display and printer emulation sessions,
as well as defining sets of global parameters.

The top pane of the tab uses a Windows-style tree structure to display the
number and type of currently-defined sessions and the sets of global
parameters affecting all the sessions.

The parameter sets are divided into the following categories (see Advanced
Properties in online Help for details):

* Sessions
Settings for all defined display and printer sessions.

* Keyboard
For setting the keyboard type and viewing or customizing keyboard
mapping and other settings.

* Mouse
For defining mouse actions.
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* Sign-on Screen
For defining any automatic startup or macro action.

* MorphExpress
For defining the GUI display.

* Display Properties
For defining the color and cursor style.

* Session Preferences
For defining the display font and ruler type.

* Options
For setting various emulation options.

Diagnostics

If you contact Technical Support with a problem, they may ask you to provide
them with special files to help them solve it. This process is explained in
“Traces and Screen Captures” on page 80.

Expand Diagnostics in the Administrator display tree to display the following
parameter:

* Troubleshooting Information
Click Collect Technical Information to open the User Information

dialog box; fill in the information requested to create the information
file (default Bsinfo.bts).

@ You must close all sessions before running Diagnostics.

The Emulation Configurator



THE BOS4GNOVA EMULATION

The BOSANOVA emulation is the environment in which you run your host
applications. The host application appears in a window with optional toolbars,
the BOSaNOVA TCP/IP menu bar, customizable macros, and customizable
display enhancements.

Starting BOSaGaNOVA TCP/IP

To start BOSaNOVA TCP/IP:
1. Click Start.
2. Select Programs * BOSANOVA TCP/IP.

3 Select By BOSENDWA Erulation

In addition, you can start BOSANOVA TCP/IP automatically by adding it to the
Windows Startup folder. To do this, place a shortcut to the BOSANOVA TCP/
IP Display Emulation (Bsmdemul.exe in your BOSANOVA TCP/IP folder) in
your Startup folder (Start Menu ¥ Programs * StartUp).

Opening a Display or Printer Emulation Session

After starting BOSANOVA TCP/IP, to begin working, open a display session or
printer session:

* C(Click the desired icon.

* Theicon: E indicates a display session.

&

» Select Sessions * Activate Session and select the desired session.

 The icon:

indicates a printer session.

» Select Sessions * Activate All to activate all sessions.

» Ifyou selected File ¥ Save Workspace the last time you closed
BOSAaNOVA TCP/IP, then you can select File > Restore Workspace to
automatically reopen all sessions.

@ All defined sessions that are not currently open are listed according to session
name in Session ¥ Activate Sessions. A session with no session name defined
is listed by its number and device model type; for example, Session 2 3477.

9 BOSANOVA XTC Thin Client



Display Emulatio

n Sessions

A truncated image of a display emulation screen is shown below:

n BOS3NOVA Emulation - [Session_1 3477FC] HEE
;Eile Edit View Seszzion: Macro Option: Window Help .- ll

@@ BiELBE 2% A ® - | Amoev e st s |

Sign 0On

PYRIGHT IEWM CORP. 19388, 1995.

Ea Fow: B Caol: 53

Figure 3: BOSaANOVA Display Emulation Session

Display Emulation Toolbar Buttons

Shows the active emulation session (when selected).

=

Shows the active printer session (when selected).

Runs the Administrator.

T

Runs the Emulation Configurator.

&

Displays Print Screen setup.

Toggles between a normal display screen and full-screen

and without the Windows menu, status, and task bars.

mode. In full-screen mode, the display screen appears larger

causes the next line to be pasted into the next input field.

Places a tab after each line of text in the Windows clipboard.
This is useful for pasting text into host fields because the tab

The BOSaNOVA Emulation
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Copies each line within the screen or selected area as a single
line with a carriage return. When pasted back into an
emulation screen, the individual lines can then be entered into
host fields by selecting Edit > Paste Tab or Edit * Paste
Field Exit.

Performs a Print Screen.

g

Runs the emulation session in GUI mode (MorphExpress),
which display menus, buttons, frames, tables and other
Windows interface features.

"'5; Decreases the font size in the active display session.

A Increases the font size in the active display session. The font

- is increased in height first, then in width. If you are using
Autosize Font (Options * Preferences in the Emulation
Configurator), clicking this button changes the minimum font
size.

® Records a macro: everything entered at the keyboard
(characters, symbols, or command keys) is recorded.
Recording continues until the macro is stopped.
NOte! Fecord E
While you are recording, a two-button toolbar
displays Pause and Stop buttons.

» Plays the selected pre-recorded macro.

arn] [ent | T | Teer rsT era Host operations toolbar functions.

e Macro toolbar. These only appear if macros are defined.

11
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Printer Emulation Sessions

BOSaNOVA TCP/IP uses a Windows-style tree structure to display printer
sessions and their status information. The following diagram shows a sample
printer session status screen.

@ If a parameter is not applicable to your connection type, it appears blank.

p BOSaNOVA Emulation - [ =

g File View Sessions Printes Help

!I@a &.’nﬂm ‘6 ‘e W X

=l Ei HDSTDE‘VIEE‘ Definiions
(3 Device Type < 3
=] System Name < >
(& Session Name < >
$# Message Queue < OSYSOPR 3
- ¥ PC Printer Definitions
a---&ga Dewvice Status
B Host Device Status < System Awvailable »
% PC Printer Status < Idle >
o# Diagnostic Mode < Off »
&[] Job Status

[+ |_§t] Tt Pane Set-ge

Figure 4: BOSANOVA Printer Emulation Session

Printer Emulation Toolbar Buttons

Shows the active emulation session (when selected).

B Shows the active printer session (when selected).

&a Runs the Administrator.

Runs the Emulation Configurator.

I Displays Print Screen setup.

The BOSaNOVA Emulation
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Starts the printer. Ifthe print queue has been paused or stopped,
this resumes printing.

Stops the printer, including any jobs currently in the print
queue. A host error message will appear, indicating that the
print queue has been stopped. Jobs in the queue remain there;
ready jobs are re-leased once the Start button is pressed or
Printer > Start is selected.

Opens Printer Session Properties, for viewing or setting print
job parameters.

Cancels the current job in the print queue. Other jobs will
continue.

Accessing Printer Session Properties

You cannot change values directly on the screen. Make changes in the Printer
Session Properties dialog box. Access the dialog box in one of three ways:

In a print emulation screen, right-click to display the popup menu and
select Properties.

From the print emulation menu bar, select Printer » Properties

&

From the printer emulation toolbar, click

General Tab

This tab contains parameters defining the printer driver and job timeout
settings.

* Print Test Page

Sends a test page to the local printer. The print session emulates a host
print device, but the output is directed to a PC printer.

Printer Driver

BOSaNOVA TCP/IP enables you to print using your default Windows
printer driver or to bypass Windows printing by defining your own
custom printer driver.

Timeout Settings

The default job timeout is 10 seconds. This is the maximum amount of
time that can elapse between buffers received from the host. If no
buffer is received within this time period, BOSANOVA TCP/IP assumes
that the end of the print job has occurred. During troubleshooting, you

13
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may need to increase this number. To restore the default value, click
Set Default Timeout.

Previous Job Attributes Tab

Displays the attribute values of the most recent host print job in the left pane
and corresponding local printer settings (converted from the host attributes by
the BOSANOVA printer emulation) in the right pane. For details, see Printer
Session Properties in online Help.

Page Setup Tab

For setting parameters such as CPI, LPI, page orientation, paper size, and paper
source. For details, see Printer Session Properties in online Help.

@ If your screen display is not clear, click the + or — box in front of an entry
several times to refresh the screen.

Diagnostics

Contains parameters for running diagnostic mode. This is for troubleshooting
print problems. For details, see “Traces and Screen Captures” on page 80.

Page Setup Tab

See Printer Session Properties in online Help for more information.

@ If your screen display is not clear, click the + or — box in front of an entry
several times to refresh the screen.

Custom Driver Considerations

In order to decide whether to use the default Windows driver or a custom
driver, you must understand how BOSANOVA TCP/IP handles print jobs.

When using the Windows driver, a data buffer (ASCII or EBCDIC) arrives at
the Windows driver. It is then output as a graphics buffer to the printer queue.
Each output buffer is approximately 40K.

When using a custom driver, a data buffer arrives at the custom driver. It is
then output as the same strings (ASCII or EBCDIC) plus commands for that
printer driver. This output is then routed to the Windows driver, where it again
is output to the printer queue as data strings plus printer commands. Because
no graphic processing is involved, each buffer is approximately 3K.
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If you are printing straight ASCII text, for example, and require speed and high
throughput, you might consider using a custom driver. Custom drivers can be
modified using the Printer Driver Editor.

Copying Between Sessions or Applications

Most Windows applications use the Windows Clipboard to transport text,
graphics, and other data. You can also use the Clipboard to copy data from a
session into another session or another application.

1. In an active display emulation session, use the mouse to mark the on-
screen text you want to copy.

2. To copy:

* select one of the copy methods from the Edit menu (Copy Continuous,
Copy by Line, or Copy Bitmap), or

* press <Ctrl+C>, or

[+

3. Ifyou are copying to a different session or application, switch to the other
session or application.

* click on the toolbar.

4. Before pasting the copied text, use the mouse to position the cursor at the
insertion point.

5. To paste:

 select one of the paste methods from the Edit menu (Paste Continuous,
Paste Tab, or Paste Field Exit), or

* press <Ctrl+V>, or

EZ

* click on the toolbar.

@ The data copied into the Windows Clipboard will remain there until replaced
by the next copy action.
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Switching Between Emulation Sessions

You can switch (or toggle) between open display and printer emulation
sessions using the toolbar, the menu bar, or the keyboard.

From the Toolbar

Click the display session button (for example, ) or the printer session

&

button (for example, ) to switch to that session.

From the Menu Bar

Select the Window menu. The bottom of the menu lists all the open display
and printer emulation sessions. A check appears next to the currently-active
session (on top session). You can switch to another session by selecting it from
this list.

From the Keyboard

In Windows, press <Ctrl>+<F6> or <Ctrl>+<Tab> to switch to the next open
emulation session.

* Press the mapped PC key for “Jump to Next Session” (default
<Alt>+<PageUp>).

* You can remap this key in the Mapping Editor. (See “Customizing the
Emulation Keyboard” on page 56.)

» Set the Session Toggle Key Combination:

i. From the menu bar, select Options » Keyboard Customization.

ii. Under Session Toggle Key Combination, select No key (for no
toggle key combination) or <Alt+Num> or <Ctrl+Num>.

iii. Check that Num Lock is on.

iv. To switch to another session, press Alt or Ctrl (depending which
combination you selected in step 2) and press the session number on

the numeric keypad. The session changes when you release both
keys.
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Using Macros

%

Macros are strings of keystrokes (characters, symbols, or command keys)
entered at the keyboard and saved for repeated use. They provide a simple way
to enter repetitive command data into a host session screen. Macros are stored
in the Windows Registry.

You will not be able to use macros from another B.O.S. emulation product; you
must re-record the desired macros in BOSaNOVA TCP/IP.

Recording a Macro

To record a macro, you must be in a display emulation session (see “Opening a
Display or Printer Emulation Session” on page 45).

1. Click it from the toolbar or select Macro ¥ Record
Macro. A popup Record toolbar appears containing, the
Pause and Stop buttons.

2. Stop recording by clicking s or selecting Macro ¥ Stop Macro. The

Record popup toolbar closes.

If you exit the emulation before clicking Stop Macro, the recorded key
sequences are lost.

3. The Save Macro As dialog box appears. Enter a name for the macro and
click Save.

If you record a macro with a key sequence that is already in use, the new key
sequence automatically replaces the existing one.

Viewing a Macro
1. Select Macro > Macro Organizer. The Macro Organizer opens.

2. Select a macro from the list and click View to open the Macro Viewer.
The macro appears as commands and text strings.

3. When you have finished viewing, click Close.
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Playing a Macro

To play a macro, you must be in a display emulation session.

There are two ways to play macros from the Sessions toolbar:

1. Click 5 The Macro Organizer 1. Click =1, A list of
player window opens. macros is displayed.

2. Click amacro. The macro plays and the || 2. Click a macro. The macro
Macro Organizer window remains open. plays and the list closes.

To play macros from the Macro menu:

a. Select Macro * Play Macro. A list of all defined macros is displayed.

b. Select a macro from the list.
Macros F |
To play macros from the Macros toolbar, click the desired Ml M

macro button.

Deleting a Macro
Select Macro ¥ Macro Organizer. The Macros Organizer opens.
Select a macro from the list and click Remove.

Confirm the delete action by clicking Yes.

el

Select another macro to delete, or click Close to close the dialog box.

The Macro Organizer and Macro Editor

With the Macro Organizer, you can manage and modify recorded macros in an
easy-to-use interface. The Macro Organizer interface displays a list of existing
macros on the left side and buttons for managing the macros on the right side.

The Macro Editor provides a convenient way for adding, removing, or
substituting macro commands or text strings in a selected macro. The Macro
Editor displays the text strings and commands of the selected macro in the
order they were recorded or entered in the Macro Organizer. For details, refer
to online Help.
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Closing a Session

To close a session:

+ close the session window by clicking the Close button ( [X] ) at the far
right of the title bar, or

» select Sessions ¥ Close Session and select the desired session

To close all sessions, select File * Exit to close BOSANOVA TCP/IP.

@ All open sessions appear in the Close Session cascade menu and are listed
according to session name. A session with no session name defined is listed by
its number and device model type; for example, Session 2 3477.

Stopping an Emulation Session

When you close the BOSaNOVA emulation, all sessions will be closed. To do
this:

* Select File * Exit, or

* Click on the window title bar.

@ If you log out of the host session without closing your host application, the
session may remain active at the host side even if BOSaNOVA TCP/IP is
closed. To prevent this, select Check for sign-on screen on exit in Sign-on
Screen in the Advanced Properties tab in the Emulation Configurator. This
displays a warning if you try to close a session when the host Sign-on screen is
not the current screen.
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CUSTOMIZING the EMULATION KEYBOARD

Accessing Keyboard Customization

* From an emulation session, select Options * Keyboard Customization
from the emulation menu bar.

e  From the Administrator:

a. In the top pane, select Installed Modules > Display Emulation; in the
bottom pane, click Configure.

b. Select the Advanced Properties tab. In the top pane, select
Keyboard; in the bottom pane, click Keyboard Customization.

Customizing Your Keyboard

1. From the Advanced Properties tab in the Emulation Configurator, select
Keyboard.

2. In Keyboard style, select Terminal or PC (that is, the style of the
keyboard you use).

3. In Keyboard type, select the keyboard you are using from the list: BOS
122-key, B.O.S. 122 PC or the standard 101/102-key keyboard. (If you are
using the BOS 122-key keyboard, you must install its driver.) The B.O.S.
122 PC keyboard does not require installation of a driver.

4. To view the default keyboard settings, click Keyboard Customization
(for details, see Keyboard Customization in online Help).

@ If the default keyboard settings are appropriate, which is the case for most
users, go to step 6 (to check host settings). If, however, you want to change
these settings, continue with step 5.

5. To change the default keyboard settings, set the following parameters (for
details, see Keyboard Customization in online Help):

Keyboard Mapping Name

The only three PC keyboard options on the list are BOS 122-key, B.O.S.
122 PC and the standard 101/102-key keyboard. Select the type of
keyboard you have.

@ The following parameters apply to all the keyboard mappings in the list;
therefore, if you change a parameter, it changes in all the listed keyboard
mappings, not just the selected one.
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Keyboard Locks
You an override these default Terminal or PC-style keyboard mappings:

»  Select Shift Lock or Caps Lock. On a terminal-style keyboard,
<Caps Lock> works like a terminal <Shift Lock> and remains in
place until the <Shift> key is pressed

* Set Num Lock at session startup: when selected, this sets <Num
Lock> when you open a session. On a terminal-style keyboard, the
numeric keypad is always numeric whether or not <Num Lock> is
selected.

Enter and Field Exit
Select the keystrokes for Enter and Field Exit. There are two choices:

*  <Field exit>=Enter; <Enter>=Right Ctrl (terminal-style keyboard
defaults)

»  <Field exit>=Right Ctrl; <Enter>=Enter

Word Processor Key Combination

If you are using Office Vision Text Assist, select the key combinations
used for text editing functions (<Alt>+<Key> or <Ctr[>+<Key>). These
key combinations are not usually supported by Windows (they perform
different functions in Windows). Selecting a key combination enables
BOSaNOVA TCP/IP to support your text editing functions. If you are not
using Text Assist, select None to improve system performance.

Session Toggle Key Combination
No key, or Alt+Num, or Ctrl+Num.

Key Sound
Select Enable to hear a click when pressing a key.

6. To view the current Host-to-PC keyboard mapping, click Edit to open the
Mapping Editor (see Mapping Editor in online Help).

If the default Host-to-PC keyboard mappings are appropriate, which is the
case for most users, go to step 12. If, however, you want to change these
mappings, continue with step 7.

7. In Categories, select a host action category (Characters on PC and Host
keyboard, Emulation controls, Host function keys, Host operations,
Macros, or Numeric pad keys).

8. Select an action from the [Host actions list] edit box. (The title on this edit
box is the category you selected in Categories.) The PC key to which that
host action is currently mapped appears in PC Key and is highlighted (blue
border) on the keyboard display.
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9. On the keyboard display, delete the current mapping of the highlighted key
by left-clicking it.

10. Remap the selected host action by left-clicking the new key to which you
want to map it. This opens Mapping for PC key. Click the button with the
desired key combination (Norm, Shift+, Ctrl+, or Alt+). If this key
combination is already mapped, you are prompted to change the existing
mapping. Click Yes to accept the change and return to Mapping Editor.
The new mapping appears in PC Key.

@ You can remap from a PC key to a host action by right-clicking the key you
want to map. The popup menu displays the current mapping of the selected PC
key combinations: Norm, Shift+, Ctrl+, and Alt+. Follow the cascading
menus to delete the current mapping or to remap the key combination to a
different host action.

11. When done, click Save As. This opens Keyboard mapping will be saved
as. In Name, type a name for your customized keyboard mapping. In
Description, you can type a more detailed description of this mapping.
Click OK to save the keyboard mapping.

12. When done, click Save As and give the customized keyboard mapping a
name. You can also add a more detailed description of the mapping
(optional). Click OK to save the keyboard mapping.
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Mapping Editor

Use the Mapping Editor dialog box to define which host actions map to which
PC key combinations.

* To map from host actions to PC keys, use the edit boxes at the top of the
dialog box and left-click.

* To map from PC keys to host actions, use the keyboard display and
right-click.

@ All the following parameters apply to the selected keyboard mapping name that
appears in square brackets [ ] in the title bar of the Mapping Editor dialog box.

Categories
Select one of the following categories:

Characters on PC and Host keyboard
This category includes all the keys for letters, numbers, and symbols.

Emulation controls
This category includes emulation actions such as <Jump to next host
session> and <Play macro>.

Host function keys
This category includes the host command keys such as <Cmd1>.

Host operations
This category includes host actions such as <Attn>, <Clear>, and
<Field +>.

Macros
This category includes recorded host macros such as <Sign off> and
<Sign on as QUSER>.

Numeric pad keys
This category includes the numbers on the numeric keypad.

[Host Actions List]

The title of this middle edit box changes according to the category you selected
in Categories. This edit box lists all the host action options in the selected
category. Select the host action you want to map to a PC key.

PC Key

Displays the PC key (or keys) to which the selected host action is currently
mapped.
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Keyboard display: The keyboard in the bottom half of the dialog box, displays
the current mapping of the keyboard mapping name shown on the title bar of
the popup dialog box. Right-click a key: it will be highlighted by a blue
border. The popup dialog box shows the key to which the selected host action
is currently mapped. From the keyboard display, you can perform the
following functions:

* Display the current mapping of any key by holding the cursor over it for
a few seconds.

* Delete the current mapping of the highlighted key by left-clicking it.

* Remap the selected host action by left-clicking the new key to which
you want to map it. This opens Mapping for PC key.

* Remap from a PC key to a host action by right-clicking the key you
wish to map. The popup menu displays the current mapping of the
highlighted PC key combinations: <Norm>, <Shift>, <Ctr]>, and
<Alt>. Follow the cascading menus to delete the current mapping or to
remap the key combination to a different host action.

OK

Not available when you select Standard 101/102-key or B.O.S. 122-key
keyboards; when you customize and save the new mapping, you can then
view this customized keyboard mapping without making any changes and
click OK.

Save As

To save a customized keyboard mapping, click Save As and give the
keyboard mapping a name; you can also add a more detailed description of
the keyboard mapping (optional).

Cancel
If you do not want to change the keyboard mapping or if you made
changes to the mapping that you do not want to save, click Cancel.

Mapping for PC Key

In the Mapping Editor, select a host operation from the list at the top of the
Editor. When you left-click a key in the Mapping Editor, you open a Mapping
for PC key dialog box. The key you clicked appears in square brackets [ | in
the title bar and the host operation you selected appears in angle brackets (< >)
in the first line.

Map the host operation you chose to one of the key-combination buttons
displayed in the Mapping for PC key dialog box:

« <Norm>  maps the selected host action to the normal key character.

+ <Shift>+... maps the selected host action to <Shift> + the key
character.
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+ CtrI>+... maps the selected host action to <Ctrl> + the key
character.

+ <Alt>+... maps the selected host action to <Alt> + the key character.

Deleting a Keyboard Mapping

%

You can remove a customized keyboard mapping from the Keyboard Mapping
Name list by deleting it. If you want to remove it from the list, but not erase it,
first Export it to a file (see “Exporting a Keyboard Mapping” directly below).
Then you can Import it later if necessary.

You cannot delete B.O.S. 122-Key or Standard 101/102-Key keyboards as they
are the standards from which you map your customized keyboards.

1. Open the Keyboard Customization dialog box (see “Accessing Keyboard
Customization” on page 56).

2. In Keyboard mapping name, select a customized keyboard mapping.

3. Click Delete to remove the keyboard mapping and return to Keyboard
Customization.

4. Click OK to save the changes and exit the Emulation Configurator.

Exporting a Keyboard Mapping

You can save a keyboard mapping to a file and send it to others on the network.

1. Open the Keyboard Customization dialog box (see “Accessing Keyboard
Customization” on page 56).

2. In Keyboard mapping name, select a customized keyboard mapping.
Click Export to open the Save As dialog box.

4. In File name, enter the Keyboard mapping name. In Save as type, select
Keyboard mapping files (*.kbm). Click Save to save the file and return
to the Keyboard Customization dialog box.

5. Click OK to exit the dialog box.
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Importing a Keyboard Mapping

You can open a keyboard mapping that has been saved to a file (for example,
by the system administrator). You can also make changes to it.

1. Open the Keyboard Customization dialog box (see “Accessing Keyboard
Customization” on page 56).

2. In Keyboard mapping name, select a customized keyboard mapping.

3. Click Import; locate the file and click Open. The customized keyboard
mapping opens directly in Mapping Editor.

@ The imported keyboard mapping overrides the keyboard type and style settings
for all the keyboard mappings listed in Keyboard Mapping Name. If you need
to change these settings, see “Customizing Your Keyboard” on page 56.

4. Make any changes and click Save As to save the new mapping.

5. Enter the new customized keyboard mapping name and click OK. Click
OK to accept the changes and to exit the Emulation Configurator.
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CUSTOMIZING the EMULATION TOOLBARS

There are six toolbars in BOSANOVA TCP/IP (listed below). Select View *
Toolbars to open the Toolbar dialog box to define which toolbars are displayed
and which buttons they contain.

The toolbars below are shown as they would appear when “floating” (that is,
when they have been dragged into the emulation screen area). When toolbars
appear under the menu bar, they do not have titles.

@ All toolbar functions are duplicated in menu items or by keyboard hotkeys.

You can display toolbars with visible borders or in the style used by Microsoft
Internet Explorer (where a button has a visible border only when the mouse
cursor is on the button). Select the kind of borders you want in the Toolbar

dialog box.
Sessions
. - Contains a button for each defined session
plus buttons for accessing the Emulation
e |@ & Bz B Configurator and Print Screen setup,
running ATF, and toggling between full-
screen and normal display mode.
General

Contains buttons for performing a print
screen, changing fonts, playing macros,
displaying print attributes, and changing

i ﬁ .-5; 4
e » [¢4[3 the ruler cursor style.
P T

General
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Host Operations

Contains buttons of these common host
commands.

Host Operations

ATH EWT HLF PRT RST SRO
CLR ERI FEX FMK HEW HOM
RON RLUP TRO OUF

Function Keys

Contains buttons for function keys.

Function keps

F1 Fi Ei 4 i i

7 P& Fa Fi0 Fii TFiz

F1i F14 TF1F Fie TFI¥ TFl&

P19 Fa0 F21 TFEZ Fi3  FE4

Printer
(Appears Only lf the in-focus SeSSiOI’l iS a
= — % @ printer emulation session.) Contains
A . * buttons for starting and stopping print jobs.
Macros
Macros B Contains buttons of all defined macros. If
Wi iz no macros have been recorded, this toolbar
L i will not appear.
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Customizing Toolbars

1. From the emulation, select View * Toolbars.

2. Select the toolbar you want to modify and click Customize. This opens
the Customize Toolbar dialog box (for details, see Customizing Toolbars in
online Help).

3. Customize the toolbar:

» To add a button, select it in the Available Buttons table on the left side
of the dialog box, and click Add.

» To remove a button, select it in the Toolbar Buttons table on the right
side of the dialog box, and click Remove.

» To display a small popup help message over interface elements when
the cursor rests on them for a few seconds, select Show Tooltips.

* To display toolbars in the same style used by the Microsoft Internet
Explorer; that is, a button has no visible border until the mouse cursor
rests on it, select Set MSIE Style.

4.  When you have made all changes, click Close to return to the Toolbar
dialog box.

Changes are not saved until you click OK in the Toolbars dialog box. This
saves the changes and returns you to the emulation. Click Reset to return the
values to the previously saved settings.

5. Click OK to save the changes and close the Toolbars dialog box. The
modifications appear as soon as that toolbar is displayed.
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Arranging Toolbar Buttons

You can arrange the order of buttons in toolbars in two ways.
* From the Customize Toolbar dialog box:
a. Select View ¥ Toolbars.

b. Select a toolbar and click Customize to open the Customize Toolbar
dialog box (for details, see Arranging Toolbar Buttons in online Help).

c. Select a button in Toolbar Buttons (on the right side of the dialog box),
and click Move Up or Move Down to reposition it. Toolbar buttons are
arranged according to the order in which they appear in the Toolbar
Buttons table.

d. When you have finished, click Close.

e. Click OK in the Toolbars dialog box to save the changes and return to
the emulation screen.

e  On the toolbar:

a. <Alt>-click a toolbar button (that is, click a toolbar button with the left
mouse button while holding down the <Alt> key).

b. Drag the button to a new location on the toolbar and release the mouse.

c. If you drag the button off the toolbar, it will be removed; to restore it,
go back to the Customize Toolbar dialog box.

Moving Toolbars

Windows supports “floating toolbars”: that is, you can click-and-drag toolbars
to different places on your screen.

* Click a toolbar and drag it onto the session area. When you release the
mouse button, the toolbar changes into a toolbox. The buttons remain
arranged in the same order.

* Click a toolbar and drag it to the bottom of the session area. When you
release the mouse button, the toolbar is displayed at the bottom of the
screen.

* Click a toolbar and drag it to either side of the session area. When you
release the mouse button, the toolbar is displayed vertically at the side
of the screen.
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EMULATION VIEWING OPTIONS

You can control various viewing options in BOSaNOVA TCP/IP:

* To determine which toolbars are displayed, select View * Toolbars in
the emulation menu bar. This opens the Toolbars dialog box.

» To display the status bar, select View ¥ Status Bar in the emulation. If
a check appears next to this menu item, the status bar appears at the
bottom of the display session screen. To turn it off, click again.

* To convert the host display to a Windows style display, select View »
MorphExpress in the emulation. MorphExpress changes the look of
the display session, converting it into a true GUI application.

@ MorphExpress only appears in the View menu if a display session is active.

HOTKEYS
BOSaNOVA TCP/IP supports the following hotkeys:

@ The hotkey examples given here are for 101/102 keyboards only.

* <Alt> + <Page Up> jumps from one session to another

+ <Alt> + <Insert> toggles between a full screen and a split screen for the
present session

* <Alt> + <Page Down> cycles between the different ruler cursor styles
» <Alt> + <F3>starts recording a macro
+ <Alt> + <F5>starts playing a macro

+ <Alt> + <F8>toggles between Test mode (in which host attributes are
displayed) and normal mode

» <Alt> + <Print Scrn>performs a print screen to the local PC printer
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MORPHEXPRESS

MorphExpress is an automated tool that converts your original host screen into
a GUI screen by:

* analyzing host screens

» automatically detecting commands and menus and converting them
from plain text to GUI buttons

* adding panels and graphic elements

» converting subfiles into tables, and options into buttons

Displaying the MorphExpress Screen

Click &

on the toolbar to toggle between the GUI display and your previous

color scheme choice (Color or Mono).

The original (non-MorphExpress) color tables are always saved.

Configuring MorphExpress

1.

From the Advanced Properties tab in the Emulation Configurator, select
MorphExpress in the top pane and click GUI Customize in the bottom
pane to open GUI Logic Configuration (for details, see Configuring
MorphExpress in online Help).

Set the parameters to define the way MorphExpress recognizes and
converts screen elements.

Click OK in each dialog box to save the changes and close the dialog box
until you exit the Emulation Configurator. The changes take effect as soon
as you return to the emulation screen.

Customizing GUI Controls

1.

From the Advanced Properties tab in the Emulation Configurator, select
Display Properties in the top pane and click Display Properties in the
bottom pane to open the Display Properties dialog box.

In Display Mode, select MorphExpress and click Customize to open the
MorphExpress Options dialog box, where you define how the controls
look.

Make changes and click OK. Click OK in each dialog box to save the
changes and close the dialog box until you exit the Emulation
Configurator. The changes take place automatically in all display
sessions.

MorphExpress
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Customizing GUI Colors

1. From the Advanced Properties tab in the Emulation Configurator, select
Display Properties in the top pane and click Display Properties in the
bottom pane to open the Display Properties dialog box.

2. Under Display Mode, select MorphExpress; under Color scheme name,
select the palette from the dropdown list.

3. Select a background color for controls from the BackColor dropdown
palette.

4. Select a background color for input fields from the BackColor dropdown
palette. (Using a contrasting color helps make input fields more
noticeable.)

5. Click Apply to make the changes. You can see how the selections look in
the sample (the top half of the dialog box). When you are satisfied with
the color schemes, click OK to close the Emulation Configurator.
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MISCELLANEOUS

PDE (Printer Driver Editor)

The application named Printer Driver Editor is a part of BOSaNOVA TCP/IP.
PDE enables you to modify custom printer drivers. For details, refer to online

Help.

Euro Symbol Support

The euro is the single currency of the European Monetary Union that was

adopted by 11 member states on 1 January 1999. These are Belgium, Germany,
Spain, France, Ireland, Italy, Luxembourg, the Netherlands, Austria, Portugal

and Finland. For more information see the Euro Web site (http://europa.eu.int/
euro) run by the European Commission.

There are now fonts, keyboard types, and code pages that add the euro symbol

character. For euro symbol support to function correctly in your B.O.S.

applications, both the host and Windows must be configured for euro symbol
support. Check your host and Windows configuration for euro symbol support
and select Euro support in the Administrator (in Administrative parameters
¥ Host language/country). If your host and/or Windows are not configured
for euro support, deselect Euro support to use the old code page.

Host Requirements

AS/400 Release (Version) Group PTF Number Info APAR Number
V3R2MO SF99205 1111523
V4RIMO SF99206 1111523
V4R2MO SF99207 1111523
V4R3MO SF99208 1111523

Miscellaneous
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Changes Required for Euro Symbol Support
The character ID for all countries was changed from 697 to 695. The following

table contains the required code changes by country:

Country Old KBDTYPE and New (Euro) KBDTYPE | Euro Euro
CCSID (code page) and CCSID (code page) | EBCDIC ANSI
Austria/Germany AGB 237 AGE 1141 0x9F 0x80
Belgium BLI 500 BLM 1148 0x9F 0x80
Canadian French CAI 500 CAM 1148 0x9F 0x80
Denmark DMB 277 DME 1142 0x5A 0x80
France (azerty) FAB 297 FAE 1147 0x9F 0x80
Finland/Sweden FNB 278 FNE 1143 0x5A 0x80
Italian ITB 280 ITE 1144 0x9F 0x80
Netherlands NEB 037 NEE 1140 0x9F 0x80
Norway NWB 277 NWE 1142 0x5A 0x80
Portugal PRB 037 PRE 1140 0x9F 0x80
Spain SPB 284 SPE 1145 0x9F 0x80
Switzerland/French SFI 500 SFM 1148 0x9F 0x80
Switzerland/German SGI 500 SGM 1148 0x9F 0x80
United Kingdom UKB 285 UKE 1146 0x9F 0x80
United States/Canada | USB 037 USE 1140 0x9F 0x80
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DTF (DATA TRANSFER FUNCTION)

Introduction to DTF

DTF (Data Transfer Functions) is a 32-bit Windows utility for transferring data
in either direction between a BOSANOVA XTC and a host. The connection
type depends on the B.O.S. client you have installed.

Data transfers are managed by file transfer profiles. These are files with an
.h2p (host-to-PC) or .p2h (PC-to-host) extension that contain information
about the data and how it is to be transferred, e.g., the source and destination
paths, the transfer type, and conversion information.

After you create a DTF profile, you have a number of options to use for
transferring the data: DTF interface (interactive mode), DTF background
mode, Profile lists (batch mode), and the Scheduler. In addition, the Send
utility provides a tool for transferring strings and running script files in display
sessions via HLLAPI.

DTF contains four components:
» The DTF Wizard helps you create new DTF profiles.

* The DTF interface displays DTF profiles in a Windows-like tree
structure. In the DTF interface, you can:

*  View profiles and profile lists
*  Create profiles

*  Change profile parameters

*  Create profile lists

*  Change profile lists

* Run data transfers in interactive mode. (See also Running DTF in
Background Mode, in online Help.)

* The Scheduler lets you define automated transfers to run on a specified
schedule or as triggered by a dynamic event.

» The Send utility lets you send strings or commands to the host.

With DTF, you can create a list of profiles and then run these multiple transfers
in background mode.

If you have used ATF for data transfer, you will be familiar with many of the
terms and procedures in DTF. For information about new terminology and
procedures in DTF, see Tips for ATF Users, in online Help.

For details about running data transfers, refer to the online Help.
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The DTF Wizard

Use the DTF Wizard to create a new DTF profile. A DTF profile contains
information about the data and how it is to be transferred. The parameters that
appear in the wizard depend on the host type and transfer direction (host-to-PC
or PC-to-host) you selected in DTF Open Profile. For details about each step
in the DTF Wizard, click Help in the wizard screen.

The DTF Interface

The DTF interface displays the selected data transfer profile or profile list. It
provides all the controls for creating DTF profiles and profile lists, viewing the
host file, and running data transfers.

Menu Bar

Use the menus in the menu bar to perform all the functions available in
DTF.

Toolbar
Use the buttons on the toolbar to perform many of the common functions
found in the menus. ToolTips define the buttons.

Panes

The top pane of the DTF interface uses a Windows-style tree structure to
display the parameters of the displayed profile or profile list. This
structure will be familiar and intuitive to you if you are familiar with
Windows Explorer in Windows 95 or Windows NT.

To use this structure:

« Ifan item has a plus sign (+) next to it, it contains nested items. Click the
plus sign to expand the item (display the nested folders).

+ Ifanitem has a minus sign (-) next to it, it is already fully expanded and all
the nested items are displayed. Click the minus sign to collapse that part of
the tree.

» The names of the parameter sets appear in black; current status values
appear in blue. Values always appear in <brackets>.

*  When you select a parameter set in the top pane, buttons and controls for
defining or changing that parameter set appear in the bottom pane.

To access online Help for the displayed dialog box, press F1, click El , or
select Help » Context-sensitive Help.

The parameters are divided into the following categories:
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General
Host type, transfer direction, transfer type, code page conversion
information.

Host
Information for finding and identifying the source or destination on the
host and for defining how the transferred data will be written on the host.

PC
Information for finding and identifying the source or destination on the PC
and for defining how the transferred data will be written on the PC.

Advanced
Advanced parameters affecting the data transfer.

The Scheduler

With the Scheduler, you can run tasks automatically, according to the time and
other conditions. You can choose to run file transfers at set periods of time, or
based on certain string triggers which occur on the host emulation screen.
You can schedule to send strings or run script files via the Send utility. You can
schedule other Windows applications to run in conjunction with file transfers.

Create a task using the Scheduler Wizard, which prompts you for all required
information.

The Scheduler Interface

The Scheduler interface resembles the DTF interface, with a top pane
containing a tree structure of all created tasks and their parameters.

The Menus

The Scheduler menu bar contains the following menus:

File
create new, open, close, save, and hide Scheduler.
Task

suspend and resume tasks. Also contains Options for setting the frequency
and intervals of the scheduled tasks.

Log
display details and write log to a file.

Help
displays this online Help topic.
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The Toolbar

The following toolbar contains the basic tools for working with tasks.

D= 3 2| 2]

Scheduler Wizard

With the Scheduler, you define data transfer tasks to be run automatically. You
can choose to run file transfers at set periods of time, or based on certain string
triggers which occur on the host emulation screen. You can schedule to send
strings or run script files via the Send utility. You can schedule other Windows
applications to run in conjunction with file transfers. Use the Scheduler
Wizard to define the tasks.

For details about each step in the Scheduler Wizard, click Help in the specific
wizard screen.

In the first screen, enter a description.

@ This is the name of the DTF task that will appear in the Scheduler list, so we
recommend using a descriptive name that will help you remember the purpose
of the task.

The Send Utility

The Send utility is a B.O.S. application for sending a simple string from the
BOSAaNOVA XTC to a specified position on a specified display session or for
processing a script file via the specified display session.

A simple string is a string which will be sent to the specified display session
either at the current cursor position or another specified position.

A script file is a series of statements (commands) to be processed. The
statements must follow a specific syntax and must be terminated with a
carriage return/line feed combination (also referred to as EOL, or End-of-
Line).

For details about Send syntax and usage, refer to online Help.
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HOST EXPLORER

Introduction

With B.O.S.’s Host Explorer, you can view your AS/400 as if it were another
drive on your BOSANOVA XTC. The Host Explorer is designed to look and
function similarly to Windows Explorer or Internet Explorer. It includes:

 access to all connected AS/400s, displaying libraries and files as if they
were folders on another network drive

» drag-and-drop copying of folders or files

 send print jobs directly from your BOSANOVA XTC to AS/400 printer
queues

 a full, customizable toolbar (with or without text labels)

Host Explorer Interface

The Host Explorer is designed to look and function similarly to Windows
Explorer or Internet Explorer.

Menu Bar

The active window contains a menu bar with the following menus: File, Edit,
View, and Help. Most of the menu functions are standard Windows-type
functions. For information on functions specific to B.O.S.’s Host Explorer,
refer to online Help.

Toolbar

The active window contains a toolbar with standard buttons (Back, Up, Cut,
Copy, Paste, Refresh, Delete, Properties, Views) and a Stop button for stopping
the current activity, while keeping Host Explorer active.

Some of the toolbar buttons (for example, Back,Views) are followed by an
arrow. As in Microsoft Internet Explorer, you click the arrow to select from a
list of options or click the button to toggle through the options.

You can hide the toolbar by deselecting Standard Buttons (View ¥ Toolbar),
or hide the button descriptions by deselecting Text Labels (View * Toolbar).

Host Explorer
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Tree View

When you first open Host Explorer, all drives appear in the tree view (left pane
of the active window):

AS/400 Folders appears at the end of your BOSANOVA XTC network list at
the same level as My Computer. Expand folders by clicking them; the contents
of the folders appear in the right pane.

Printer appears at the end of each AS/400’s list of folders. Click the Printer
folder to view (in the right pane) all the printer devices on that AS/400. You
can connect appropriate PC printer drivers to AS/400 printer devices and then
send print jobs directly from your PC to AS/400 printer queues. See Printing
from Your PC to an AS/400 Printer.

Status Bar

The bottom of the active window contains the Status Bar. This displays the
current status of Host Explorer; for example, Reading (if trying to access the
host), Ready, Pasting, etc.
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REMOTE COMMAND

Introduction

With B.O.S.’s Remote Command Utility, you can send an AS/400 CL
command (or commands) to a host system from a BOSANOVA XTC.

Syntax

BSRMTCMD command [//system] /z

or

BSRMTCMD /1 [drive][path]filename [/q] [//system] [/z]

Parameters

@ Parameters appearing in the above syntax in [brackets] are optional.

command
The AS/400 CL command, with parameters. This is the command to be
sent and executed on the specified AS/400 host system.

n
Read commands from the specified file; the filename (and optional
path) must be separated from the /I by a space.

filename

The name of the file containing the AS/400 commands. The file must
be a text file with only one command per line. If the filename is a long
name containing a space, you must quote the entire filename—
including the full path—in apostrophes (').

Q

When using the /I parameter (sending commands from a batch file), any
error occurring appears on the BOSANOVA XTC screen, prompting
you to select Y or N (to continue or not). The /Q parameter suppresses
all error messages and assumes Y whenever an error occurs.

/Isystem
Name of the system on which the commands are to be run. If not
defined, the default system name is used.

IZ.
If selected, all messages other than error messages are suppressed.

Remote Command
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Examples

« /2or/H
Displays help. (Using the command BSRMTCMD without any
parameters also displays help.)

Example 1

In this example, the AS/400 CL command CRTLIB BOSTEST (create a library
called “Bostest”) was sent to the default host.

rmtcmd crtlib bostest

Example 2

In this example, the file Tuesday.txt, located on drive D: in the folder \Remote,
was sent to the host Mainsys.

BSRMTCMD /I D:\Remote\tuesday. TXT //mainsys
Example 3

Here is a sample command file as used in Example 2, above:
crtlib boscstlib

chkobj bsrrr
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TROUBLESHOOTING

Printer Session

In a printer session, if you selected Current Windows Driver (General tab)
and you saved print output in ASCII format (Diagnostics tab * Save to ASCII
file), do not click Collect Technical Support Information because the
resulting file may be too large.

Euro Support

For euro symbol support to function correctly in your applications, both the
host and Windows must be configured for euro symbol support. If you receive
a euro symbol support error, check your host and Windows configuration for
euro symbol support and select Euro support in the Administrator (in
Administrative parameters » Host language/country). If your host and/or
Windows are not configured for euro symbol support, deselect Euro support
to use the old code page. For details, see “Euro Symbol Support” on page 70.

Traces and Screen Captures

When you experience problems with an emulation session, Technical Support
may request that you provide them with files to help them solve the problem.
Prepare files, as follows:

1. To help debug a problem, you may be asked to record a trace (*.trc or *.bts
files) or create a screen captures (*.scn files). This is done from either the
Emulation Configurator (Advanced Properties ¥ Diagnostics) or the
Router Configurator. In addition, you may be asked to record a print
output (*.asc or *.ebc files) from printer emulation sessions.

2. Then, send the technical information file (default name is: Bsinfo.bts)
from the Administrator (Diagnostics * Troubleshooting Information).
The technical information file automatically includes all *.trc, *.scn, *.bts,
*.asc, and *.ebc files created.

Recording a Telnet Trace

Record a Telnet Trace when you have problems with an display emulation
session.

To record a trace:
1. Close all applications.
2. Inthe Emulation Configurator, select the Advanced Properties tab.

3. Expand Diagnostics and select Record Telnet Trace in the top pane.

Troubleshooting
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4. In the bottom pane, select Record Telnet Trace and specify a filename
and location.

5. Create screen captures, if required (see the next section).

6. Run an emulation. Make sure you run the TCP/IP trace on the first session
only!

7.  When the error occurs again, close the emulation. Trace data is written to
the file specified in step 4, above.

8. Prepare the information file for Technical Support; see “Preparing the
Information File” on page 82.

Screen Capture

Playback Recorded Screens

If selected, you must specify the playback file (see Record Screens for
Playback, below) or use the pulldown list of the last four previously stored
files.

Record Screen for Playback

Creates a file with “snapshots” of the display session screens. Enter the
filename (default Demo.scn), using the extension .scn. The file is
automatically created in the BOSaNOVA TCP/IP installation folder (or
another folder, if defined).

Record only works for the first (display) session; Playback can be run during
any display session. The screens are played back in the same sequence in
which they were recorded.

To record a screen capture:
1. Close all open sessions.
2. Inthe Emulation Configurator, select the Advanced Properties tab.
3. Expand Diagnostics and select Screen capture in the top pane.
4. In the bottom pane:
a. Select Record screen for playback.

b. If you don’t want the screen grabs to be written to Demo.scn, browse
for another file; note that all screen captures will be recorded in the file
selected.

c. Click OK.
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5.

Continue at step 6 (“Run an emulation”) in the previous section. Note that
each screen that is opened when you run the emulation will be captured
and placed in the file selected in 4b, above.

From a Printer Session

A

In an open Printer session, right-click.

Select Properties.

Select the Diagnostics tab.

Select Activate Diagnostic Mode and select the output option.

Prepare the information file to send to Technical Support for analysis; see
Preparing the Information File, directly below.

Preparing the Information File

Make sure that you have created all the trace files and screen captures required
by Technical Support before preparing the information file.

Close all sessions.
Run the Administrator.

In the top pane, expand Diagnostics and select Troubleshooting
information.

In the bottom pane, click Collect Technical Information to open the User
Information dialog box (for details, see Collecting User Information,
below

Complete the information and save the user information file (default name
Bsinfo.bts).

The user information file automatically includes all trace and screen
captures. Send the file (as an e-mail attachment) to Technical Support for
analysis.

Troubleshooting
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Collecting User Information

Use this dialog box to collect diagnostic information in the Administrator and
to collect printer troubleshooting information in Printer Session Properties >
Diagnostic.

The information you enter in these fields will be written to a text file when you
click OK. The default file is Bsinfo.bts in the BOSANOVA TCP/IP installation
folder. Include this file along with the trace (dump) files or recorded screens
for Technical Support.

The file also automatically includes other information, depending on the origin
(Administrator or Printer Session Properties). When run from the
Administrator, data about your system, all defined sessions, and EBCDIC to
ANSI translation tables, are automatically captured and added to the file.
When run from Printer Session Properties, a subset of this information is
captured (system information plus the specific printer session only).

Name
By default, the name you used when installing BOSaNOVA TCP/IP will
be used. You can change this.

Company
By default, the company name you used when installing BOSANOVA
TCP/IP will be used. You can change this.

Address
Enter your full mailing address, including the postal code and country.

Phone Number
Enter a daytime phone number where we can reach you.

E-mail Address
(If available)

Tech Support Call #
This number will be provided by Technical Support. Make sure to include
it so that your diagnostic files can be properly tracked.

Host Type
Enter your host type (AS/400, System/36, AS/36, etc.).

Host OS Version
Enter the complete version number of your host operating system.

Description

Describe the problem carefully. Under what circumstances does the
problem occur? Are you able to duplicate it? Have you made any changes
to your connectivity hardware or software that could contribute to this?
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Contacting Technical Support

Before Contacting Technical Support:

1. Refer to the appropriate topic in the Troubleshooting sections. The
problem may be something you can solve on your own.

2. Ifyou can’t solve the problem by yourself, run the Administrator. In the
top pane, expand Diagnostics and select Troubleshooting information.
In the bottom pane, click Collect Technical Information to open the User

Information dialog box. Fill in the form before contacting Technical
Support. If contacting us via fax, include a printout of this form;

otherwise, have it handy when you call us.

Web site

http://www.bosanovathinclient.com

BOSANOVA, Inc.,
North America

Tel: sales: (866) 865-5250; (623) 516-0029
support: (866) 864-5250

Fax: (623) 516-8697

sales@bosanova.net support@bosanova.net

BOSaNOVA, Inc., France

Tel: +33-1-53-14-59-80
Fax: +33-1-53-14-01-74
sales@bosanova.fr support@bosanova.fr

B.O.S., Israel

Tel: +972-4-990-7555
Fax: +972-4-999-0334
sales@boscom.com support@boscom.com

Troubleshooting
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